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History of GIS: Early History of Mapping and 

Cartography in Bangladesh 

Md. Abeed Hossain Chowdhury, Project Manager, Crop Zoning Project 

Bangladesh Agricultural Research Council 

Email: abeedchowdhury@gmail.com 

 

Introduction 
 

Geographic Information Systems (GIS) and cartography have played a crucial role in 

Bangladesh’s development, from early colonial land surveys to modern satellite-based 

geospatial analysis. 
 

 

1. Pre-Independence Era: Colonial Surveys (1760–1947) 
 

Key Developments: 

• 1760s–1800s: The British East India Company conducted the first systematic land 

surveys for taxation and revenue collection (e.g., Cadastral Surveys). 

• 1850s: The Great Trigonometrical Survey of India (under Sir George Everest) 

established geodetic control points in Bengal. 

• Early 1900s: Topographic maps were created for military and administrative purposes, 

often hand-drawn with limited accuracy. 

Legacy: 

• Many colonial-era maps are still used as reference documents in land disputes. 

• The District Gazetteers included early geographic and demographic data. 
 

2. Post-Independence: Early Modernization (1947–1971) 
 

Key Developments: 

• 1950s: Establishment of the Survey of Pakistan, which continued cadastral and 

topographic mapping. 

• 1960s: Introduction of aerial photography for floodplain and riverine mapping. 

 

Limitations: 

• Manual cartography dominated, with slow updates. 

• Limited accessibility of maps for civilian use. 
 

3. Birth of GIS in Bangladesh (1971–1990s) 
 

Key Milestones: 

• 1973: Creation of the Survey of Bangladesh (SOB), responsible for national mapping. 

• 1980: Establishment of SPARRSO (Bangladesh Space Research and Remote Sensing 

Organization), introducing satellite remote sensing. 

• 1989: First use of Landsat imagery for flood monitoring. 

 

Early GIS Applications: 

• Disaster Management: Cyclone and flood mapping. 

• Agriculture: Crop monitoring using NOAA AVHRR data. 

mailto:abeedchowdhury@gmail.com
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4. Digital Revolution (1990s–2010s) 
 

Key Advancements: 

• 1991: First digital topographic maps developed by SOB. 

• 1997: Digital AEZ map and digitized LRIS by BARC 

• 1998: Launch of Bangladesh’s first GIS-based land record system  

(DLRS – Digital Land Record System). 

• 2000s: 

• Google Earth (2005) increased public access to geospatial data. 

• River erosion studies using RS and GIS gained importance. 

 

Institutional Growth: 

• Bangladesh Agricultural Research Council (BARC) adopted GIS for soil mapping. 

• Local universities (e.g., BUET, KU) introduced GIS courses. 
 
 

5. Modern Era (2010–Present): AI, Drones, and Big Data 
 

Recent Developments: 

• 2013: Bangladesh Satellite-1 project initiated (launched in 2018). 

• 2016: Digital Bangladesh Vision promotes GIS for smart agriculture & urban 

planning. 

• 2020s: 

• Drone-based land surveys by SOB. 

• AI-powered flood prediction models (e.g., using Sentinel-1 SAR data). 

 

Key Applications Today: 

✓ Disaster Management: Real-time flood mapping (e.g., FFWC uses GIS). 

✓ Agriculture: Soil test-based fertilizer recommendation (Khamari App). 

✓ Urban Planning: Dhaka’s Detailed Area Plan (DAP) uses GIS. 
 
 

6. Challenges & Future Directions 
 

Persisting Challenges: 

• Fragmented data across agencies (SoB, BARC, LGED). 

• Limited open-data policies. 

• Shortage of skilled GIS professionals. 

 

Future Opportunities: 

• National GIS Policy for data standardization. 

• Expansion of drone & IoT-based mapping. 

• Integration with AI (e.g., automated land classification). 
 
 

Conclusion 
 

From colonial land surveys to AI-driven geospatial analytics, Bangladesh has made 

remarkable progress in GIS and cartography. With continued investment in satellite 

technology, digital infrastructure, and workforce training, Bangladesh can leverage GIS 

for sustainable development, climate resilience, and smart agriculture. 
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GIS and Remote Sensing Works in Crop Zoning Project 

Hasan Md. Hamidur Rahman, Director (Computer & GIS Unit) 

Bangladesh Agricultural Research Council 

Email: h.rahman@barc.gov.bd 

 

Background 

➢ Bangladesh Agricultural Research Council (BARC) has been developing the crop 

zoning system for maintaining a sustainable agricultural production system in order to              ensure 

long-term food security for the people. 

➢ The government of Bangladesh put emphasis on crop zoning based land use planning 

in 8th five year plan policies and strategies of the crop sub-sector. 

➢ On February 4, 2021, at the unveiling ceremony of “The 100 Agro Technologies Atlas" 

published by BARC, the Honorable Prime Minister of Bangladesh mentioned the necessity for 

crop zoning and requested to take action in this regard. 

 

Basic Information 
 

• Implementing Organization: 

Bangladesh Agricultural Research Council (BARC) 

 

• Partner Organizations: 

1. Soil Resource Development Institute (SRDI)  

2. Institute of Water Modeling (IWM) 

 

• Focal Point Organizations: 

1. Department of Agriculture Extension (DAE) 

2. Bangladesh Agricultural Research Institute (BARI) 

3. Bangladesh Rice Research Institute (BRRI) 

4. Bangladesh Institute of Nuclear Agriculture (BINA) 

5. Bangladesh Wheat & Maize Research Institute (BWMRI) 

 

Objectives 

The overall objective is to develop crop zoning in support of GoB’s strategy to facilitate a more 

efficient and sustainable agricultural production systems in the context of food and nutritional 

security of the country. More specifically the objectives are: 

• Provide crop zoning information to agricultural policy planners/ decision makers in 

creating a “farm friendly” policy framework to sustain an economically viable agriculture 

sector through conserving and protecting farmland for current and future generations; 

• Facilitate and strengthen farmers and other stakeholders’ access to information on suitable 

crop, fertilizer recommendation and others related to increased agricultural productivity and 

farm income; 

• Awareness building on the utility and use of crop zoning information system to help 

farmers, extension personnel, policy makers’ transition to more sustainable agricultural system. 

mailto:h.rahman@barc.gov.bd
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Data used in Crop Zoning 

➢ Upazila wise land and soil characteristics, soil chemical properties and soil and 

topography maps. 

➢ 30 years (1988-2017) of weather data (daily temperature, precipitation, humidity, 

sunshine, wind speed, cloud cover). 

➢ Information on crop-based land and soil requirements, agro climate requirement etc. 

➢ Limitation rating made on the basis of requirement of crop based 

➢ land and soil, agro climate, etc. in determining crop suitability. 

➢ Information on variety information, yield, life span of 76 crops. 

➢ Information on determining crop-based fertilizer recommendations and application 

methods. 

➢ Socio-Economic Data and Indicators for Assessing Financial Benefits in supporting the 

Introduction of Sustainable Crop Production Systems. 

➢ Upazila wise land type, roughness, soil texture, soil firmness, extractable juice status, 

water recession status, drainage status, soil reaction, salinity map. 

➢ Pre-Kharif, Kharif and Rabi production periods and cold and hot temperature zone map. 

➢ Upazila-wise administrative map (union and mauza boundaries, settlements, water 

bodies, rivers, pastures, etc.). 

➢ Digital Elevation Model (DEM), Satellite Imagery. 

➢ Existing land use map.
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Crop Zoning Information System 

 

 
 

➢ Edaphic Suitability Assessment     of Crop    

➢ Agro-climatic Suitability       Assessment of Crop 

➢ Bio-physical Suitability  Assessment of Crop 

➢ Potential Crops and their Extents 

➢ Cropping Patterns with GM and BCR 

➢ Fertilizer Recommendation 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



6 | P a g e  

 

Khamari Mobile App 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

➢ Location based Crop Suitability    

➢ Location based Soil Fertility Status 

➢ Location based Fertilizer Recommendation 

➢ Cropping Patterns with GM and BCR 

➢ Crop Zones 

➢ Saved Information for Offline Viewing 
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Crop Suitability, Land Use, Crop Profitability, Fertilizer Recommendation 
 

 

 

Agri-advisory Portal 
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Future Plan 
 

➢ Develop National Crop Production Planning Tool using AI 

➢ Develop Khamari app as an integrated platform (one stop solution) 

➢ Updating of Land Use and Land Cover for all Upazila. 

➢ Capture LiDAR data for precise land height 

➢ Develop Satellite based crop monitoring and yield estimation 

➢ Institutionalize Demonstration Trial of Khamari app (through DAE). 

➢ Capacity Building of Manpower 

➢ Initiate Crop Modelling for Assessing Future Scenario of Crop Zoning 
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Basic Concepts of GIS Technology 

Abid Kamal 

GIS Analyst, Crop Zoning Project  

Bangladesh Agricultural Research Council 

Email: geoabid38@gmail.com 
 

 

Introduction 

➢ GIS stands for Geographic Information System. 

➢ It is a system designed to capture, store, analyze, and display spatial or geographic data. 

➢ GIS combines hardware, software, and data to provide powerful tools for understanding 

and visualizing location-based information. 

 

Benefits of GIS 

Improved Decision-Making: 

➢ GIS provides valuable insights by visualizing complex data in a spatial context. 

➢ It enables better-informed decision-making by integrating multiple layers of information. 

Enhanced Efficiency: 

➢ GIS automates tasks, streamlines workflows, and reduces manual effort. 

➢ It saves time and resources by optimizing processes like route planning or data analysis. 

Increased Collaboration: 

➢ GIS facilitates data sharing and collaboration among individuals and organizations. 

mailto:geoabid38@gmail.com
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➢ It enables stakeholders to work together, contributing to better planning and decision- 

making. 

 

Components of GIS Hardware: 

➢ Computers, servers, scanners, printers, GPS devices, and other physical equipment used 

to collect and process data. 

Software: 

➢ GIS software provides the tools and functionalities to manage, analyze, and visualize 

spatial data. 

➢ Examples: ArcGIS, QGIS, Google Earth, and many others. 

 

Figure: Components of GIS 
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Data: 

➢ Geographic data is the foundation of GIS. 

➢ It includes both spatial data (e.g., maps, satellite images) and attribute data (e.g., 

population, temperature). 

➢ Data can be collected from various sources, such as surveys, remote sensing, or existing 

datasets. 

GIS Data Types and Data Sources Data Types: 

➢ Spatial data: maps, satellite imagery 

➢ Attribute data: population, temperature, land use 

➢ Importance of integrating spatial and attribute data 

 

Data Sources: 

➢ Data collection methods: surveys, remote sensing, GPS 

➢ Open data sources: government agencies, research institutions 

➢ Data quality considerations 

 

GIS Data Management 

➢ Data storage and organization 

➢ Data formats: raster vs. vector 

➢ Database management systems (DBMS) 

 

GIS Analysis 

➢ Spatial analysis techniques: buffering, overlay, proximity analysis 

➢ Geoprocessing tools and operations 

➢ Modeling and simulation capabilities 
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GIS Visualization 

➢ Maps and cartography 

➢ Symbolization and thematic mapping 

➢ 3D visualization and fly-throughs 

 

GIS Applications in Agriculture 

 

1. Crop Monitoring and Management 

• Use satellite imagery and drones to monitor crop health. 

• Identify areas with stress due to pests, diseases, or lack of nutrients. 

• Apply fertilizers or pesticides only where needed (site-specific management). 

2. Soil Mapping and Analysis 

• Map soil types, textures, pH, and 

moisture levels. 

• Support land suitability analysis for 

different crops. 

• Optimize tillage and irrigation plans. 

3. Precision Farming 

• Combine GPS with GIS for 

precision planting, fertilizing, and 

harvesting. 

• Reduce waste and maximize yield 

by analyzing spatial variability in 

fields. 

4. Irrigation Management 

• Map irrigation zones based on crop needs and soil moisture data. 

• Improve water use efficiency using remote sensing and real-time sensors. 

5. Yield Prediction and Mapping 

• Analyze historical yield data spatially to forecast future output. 

• Create yield maps that guide decisions for upcoming seasons. 

6. Climate and Weather Analysis 

• Integrate weather data for forecasting and crop planning. 

• Identify areas prone to droughts, floods, or frost. 

7. Pest and Disease Mapping 

• Map and monitor outbreaks of pests or diseases across regions. 

• Plan and implement targeted intervention strategies. 

8. Farm Planning and Land Use Management 

• Plan crop rotations, buffer zones, and farm infrastructure using spatial data. 

• Ensure sustainable use of land and natural resources. 
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Water Resource Management 

Applications 

➢ Watershed modeling 

➢ Flood risk assessment 

➢ Water quality monitoring 

 

 

 

 

 

Other Applications: 

 

• Urban Planning 

• Disaster Management 

• Environmental Management 

• Education and Research 

• Archeology 

• Real Estate 

• Healthcare 

• Many More …… 

 

 

Conclusion 

GIS is a powerful tool for managing and analyzing spatial data. Its applications span across diverse 

fields, including urban planning, environmental management, emergency response, public health, 

and transportation. With its ability to integrate data from various sources and provide 

visualizations, GIS helps in making informed decisions and solving complex problems.
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Overview of ArcGIS 

Al-Helal 

Programmer, Computer & GIS Unit 

Bangladesh Agricultural Research Council 

Email: al.helal@barc.gov.bd 
 

 

The ArcCatalog application provides a Catalog window that is used to organize and manage 

various types of geographic information for ArcGIS Desktop. 

 

Items in the Catalog Tree View 

Folder Connections-Connections to file folders containing datasets and ArcGIS documents. 

Toolboxes- Geo-processing tools and scripts used in ArcGIS. 

Database Servers-SQL Server Express instances configured to store desktop or workgroup 

geodatabases. 

Database Connections-Connections 

to databases and enterprise 

geodatabases. 

GIS Servers-Connections to ArcGIS 

Server and OGC server sites. 

My Hosted Services-When you 

connect to and sign in to a portal, 

you can access the web layers and web maps you own or that have been shared with you. 

Ready-To-Use-Services-When you connect to ArcGIS Online, you can access a set of publicly 

available worldwide services. 

ArcMap represents geographic information as a collection of layers and other elements in a 

map. ArcMap is where you display and explore GIS datasets for your study area, where you 

assign symbols, and where you create map layouts for printing or publication. ArcMap is also 

the application you use to create and edit datasets. 

ArcMap is one of the primary desktop GIS applications included in the ArcGIS Desktop suite. 

It is used to perform a wide range of common GIS tasks as well as specialized, user-specific 

tasks. Here is a list of some common workflows you can perform: 

• Work with maps 

• Print maps 

• Compile and edit GIS datasets 

• Use geo-processing to automate work and perform analysis 

• Organize and manage your geodatabases and ArcGIS documents 

• Publish map documents as map services 

mailto:al.helal@barc.gov.bd
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• Share maps, layers, geo-processing models, and geodatabases with other users 

• Document your geographic information 

• Customize the user experience 
 
 

 

When you save a map, you have created in ArcMap, it will be saved as a file on disk. This is 

an ArcMap document and is referred to as a map document or mxd since the file name extension 

(.mxd) is automatically appended to your map document name. You can work with an existing 

.mxd file by double-clicking the document to open it. This will start an ArcMap session for that 

.mxd file. 
 

Map documents contain display properties of the geographic information that you work with 

in the map—such as the properties and definitions of your map layers, data frames, and the 

map layout for printing—plus any optional customizations and macros that you add to your 

map. 

ArcMap represents geographic information as a collection of layers and other elements in a 

map view. There are two primary map views in ArcMap: the data view and the layout view. 

In ArcMap data view, the map is the data frame. The active data frame is presented as a 

geographic window in which map layers are displayed and used. Within a data frame, you work 

with GIS information presented through map layers using geographic (real-world) coordinates. 

These will typically be ground measurements in units such as feet, meters, or measures of 

latitude-longitude (such as decimal degrees). The data view hides all the map elements on the 

layout, such as titles, north arrows, and scale bars, and lets you focus on the data in a single 

data frame, for instance, editing or analysis. 
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When you're preparing your map's layout, you'll want to work with your map in page layout 

view. A page layout is a collection of map elements (such as a data frame, map title, scale bar, 

north arrow, and a symbol legend) arranged on a page. Layouts are used for composing maps 

for printing or export to formats such as PDF. 

The Layout view is used to design and author a map for printing, exporting, or publishing. You 

can manage map elements within the page space (typically, in inches or centimeters), add new 

map elements, and preview what your map will look like before exporting or printing it.  
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Common map elements include data frames with map layers, scale bars, north arrows, symbol 

legends, map titles, text, and other graphic elements. 

Within the data frame, you display geographic datasets as layers, where each layer represents 

a particular dataset overlaid in the map. Map layers help convey information through: 

• Discrete feature classes such as collections of points, lines, and polygons. 

• Continuous surfaces, such as elevation, which can be represented in a number of ways. For 

example, as a collection of contour lines and elevation points or as shaded relief. 

• Aerial photography or satellite imagery that covers the map extent 

Example map layers include streams and lakes, terrain, roads, political boundaries, parcels, 

building footprints, utility lines, and orthophoto imagery 

In addition to representing geographic information, each layer's map symbols, colors, and 

labels help describe the objects in the map. You can interact with the layers displayed in each 

data frame to query each feature and see its attributes, perform analytical operations, and to 

edit and add new features to each dataset. 

 

 
 

A layer doesn't store the actual geographic data. Instead, it references a dataset, such as a feature 

class, an image, a raster, and so on. Referencing data in this way allows the layers on a map to 

automatically reflect the most up-to-date information in your GIS database. 

In ArcMap, you specify properties for each map layer, such as its map symbols and labeling 

rules, by right-clicking the layer in the table of contents and clicking Properties or by double- 

clicking on the layer name. 
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The Table of Contents window lists all the layers on the map and shows what the features in 

each layer represent. The check box next to each layer indicates whether its display is currently 

turned on or off. The order of layers within the Table of Contents window specifies their 

drawing order in the data frame. 

The map's table of contents helps you manage the display order of map layers and symbol 

assignment, as well as to set the display and other properties of each map layer. 

A typical map might have an image or a terrain base (such as shaded relief or elevation 

contours) near the bottom. Above that layer are a basemap; polygon, line, and point features; 

and annotation and other reference information. 
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The Standard toolbar most typically appears at the top of the ArcMap application window 

and is used for map printing, creating a new map, opening an existing map, saving your map, 

starting related ArcGIS applications, and more. 

 

Clicking ‘Add Data’ Button Opens the 

‘Add Data’ Dialog box for adding data of 

all compatible types to ArcMap. 
 

• Double-click to open items that house 

other items, such as a                       folder or feature 

dataset.  

• You will know what items are data and 

what items are “containers” for other 

data based upon the icon 

• Review File Icons 

• Control+Click or Shift+Click to select multiple items. 

 

“Add Basemap” option opens the dialog box to add one of many basemaps available from 

ArcGIS Online. 

• These maps are streaming over the        
Internet; thus, the speed of drawing will 

be based upon your internet speed. 

• These basemaps are in WGS 84 Web 

Mercator, and unless your project is in 

the same projection, take care when 

digitizing and georeferencing data to 

streaming basemaps. You may be 

affecting you overall                                                     accuracy and 

precision. 
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Geo-Referencing Techniques 

Mustafa Atikul Mazid, 

Remote Sensing Analyst, Crop Zoning Project 

Bangladesh Agricultural Research Council 

Email: tushar060401@gmail.com 

 

Add Image to ArcGIS  

 

You will add an image to your map that does not have statistics or georeferencing data. You 

will use tools in ArcGIS Pro to calculate the statistics so the image will load more smoothly as 

you work with it and identify where the map was placed without its georeferencing data. 

 

1. On the ribbon, click the View tab, and in the 

Windows group, click Catalog Pane. 

 

2. In the Catalog pane, click the arrows to 

expand provided data folder, Georeferencing. 

Right- click AOI and choose Add To Current 

Map. 

 

The Calculate statistics for AOI window appears notifying you that the image you are adding 

does not have statistics and prompting you to calculate them. You will accept and calculate 

statistics for your image. 

1. In the Calculate statistics for AOI 

window, click Yes. 

AOI appears in the Contents pane, but for now, 

you don't see it on the map. A message in the 

upper right corner warns you that the image 

does not have coordinate system information. 

This is expected because the image you added 

did not contain any spatial reference 

information. Before you remedy this, you'll 

locate the image on the map. 

 

2. In the Contents pane, right-click AOI and choose Zoom To Layer. 

3. The map now shows the image of the area you have downloaded. However, since it is 

not georeferenced, the application cannot locate it and displays it near the latitude and 

longitude (0,0), as you can see indicated in the lower part of the map view. 

mailto:tushar060401@gmail.com
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Create Control Points and Apply a Transformation 

You'll add control points to the image and apply a transformation to complete the 

georeferencing process. 

When you georeference an image, you define its location using map coordinates and assign the 

coordinate system of the map frame to the image. You do this by adding control points that 

identify a location in the image and its corresponding location in the reference basemap. In this 

section, you will identify and add several control points. 

On the Georeference tab, in the Adjust group, click Auto Apply once to turn it off. 

 

When Auto Apply is active, it automatically applies a transformation to the source layer and 

updates the display as control points are added, removed, or modified. For the purpose of this 

exercise, you want Auto Apply to be off to be able to observe your control points in their 

original location. You'll apply the transformation in the next section. 

1.   In the map extent zoom to the location for the first control point. 

2.  Click the Georeference tab, and in the Review group, click Control Point Table. Reposition 

the table below the Map view. 

3. Click Fit to Display to add image in the current map extent  
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On the Georeference tab, in the Adjust group, click Add Control Points. 

 

To add a control point, you'll first left click a location and then right click in the corresponding 

location. Provide the X, Y coordinate in Decimal Degree. 

 

 

Review the control point table. 

The first control point is now listed. The Source X and Source Y values represent the 

coordinates for the From point, and the X Map and Y Map values represent the coordinates for 

the To point. 

 

In a similar procedure add more three control points.   
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Apply a Transformation 

In this section, the default transformation to the image based on the four control points will be 

applied. 

1. With the mouse scroll wheel, zoom out until you can see the entire historical image. 

2. On the Georeference tab, in the Adjust group, click Apply. 

 

The source image is automatically shifted, scaled, and rotated to make every source and target 

control point pair coincide as much as geometrically possible. 

3. If necessary, refine the adjustment by adding additional control points and clicking 

Apply again. 

4. Review the control point table. 

5. In the control point table, verify the transformation method applied is 1st Order 

Polynomial (Affine). 

 

6. In the control point table, click the 1st Order Polynomial (Affine) drop-down arrow. 

There are various transformation types available in the list. You only see five of them, because 

other transformations require a higher number of control points to be created. 

 

For now, you'll keep the 1st Order Polynomial (Affine) transformation. 

7. In the control point table, review the individual residual values associated with each 

control point. 
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The residual value of a control point is the difference between where the source point 

and the target point display on the map. Residuals closer to zero are considered more 

accurate. 

8. At the top of the map, expand and review the on-screen georeferencing details. 

For each control point, the residual is the difference between where the From point 

displays in the map and the actual location that was specified. The total error is 

computed by taking the root mean square (RMS) sum of all the residuals to compute 

the RMS error. The value describes how accurately the selected transformation method 

is able to fit all of the control points to their specified location. When the error is 

particularly large, you can remove and add control points to adjust the error. However, 

a large error may also mean that the selected transformation method is unable to 

accurately fit the points to their specified location. However, if the points are all 

properly selected and a large error is reported, it typically means that a different 

transformation is required. 

The forward residual shows you the error in the same units as the data frame spatial 

reference. The inverse residual shows you the error in the pixel units. The forward-

inverse residual is a measure of how close your accuracy is, measured in pixels. 

Residuals closer to zero are considered more 

accurate. 

9. In the map view, zoom out to display the full image. 

10. Review the transformed image. If the result is    

            reasonably satisfactory, we can save it. 

11. On the Georeference tab, in the Save group,  

Click Save. 
 

Saving the image writes the georeferencing information in an associated auxiliary file. 

This information includes where the image should be positioned and how much it 

should be shifted, scaled, and rotated. 

12. On the Quick Access Toolbar, click Save to save the project. 
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Creating & Editing Shapefiles 

Mustafa Atikul Mazid, 

Remote Sensing Analyst, Crop Zoning Project 

Bangladesh Agricultural Research Council 

Email: tushar060401@gmail.com 

 

Create A New Shapefile 
 

You can create new shapefiles in ArcCatalog or by using the Create Feature Class tool. When 

you create a new shapefile, you must define the types of features it will contain, whether those 

features will represent routes (m-values), and whether those features will be three-dimensional 

(z-values). These properties can't be modified after the shapefile has been created. You can also 

define the coordinate system of the shapefile. If you choose to define the shapefile coordinate 

system later, it will be classified as Unknown until then. The process of defining the new 

shapefile's attributes is separate from creating the shapefile itself. After creating the item, define 

its attributes by right-clicking it in ArcCatalog and clicking Properties. Because it must contain 

at least one attribute column. ArcCatalog adds a default column to the shapefile when it is 

created. For shapefiles, an integer column named Id is added as an attribute. Add the 

appropriate attributes to your shapefile. After the new attributes have been added as part of the 

shapefile, you can delete the default column if you decide you don't want to use it.  

 

1. Select a folder or folder connection in the 

Catalog tree.  

2. Click the File menu, point to New, then 

click Shapefile.  

3. Click in the Name text box and type a 

name for the new shapefile.  

4. Click the Feature Type drop-down arrow 

and click the type of geometry the 

shapefile will contain.  

5. Click Edit to define the shapefile's 

coordinate system.  

6. Select, import, or define a new coordinate 

system.  

7. It's highly recommended that you define 

the shapefile's coordinate system now; however, you can postpone this step until a later 

time. For more information, see Fundamentals of a shapefile's coordinate system and 

Click OK.  

8. If the shapefile will store polylines representing routes, check Coordinates will contain M 

values.  

9. If the shapefile will store three-dimensional features, check Coordinates will contain Z 

values and Click OK. 

 

The new shapefile appears in the folder's contents. 

mailto:tushar060401@gmail.com
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Editing Features in a Shapefile 

Digitizing, the process of converting features into a digital format, is one way to create data. 

There are several ways to digitize new features. These include digitizing on-screen or heads up 

over an image, digitizing a hard copy of a map on a digitizing board, or using automated 

digitization. 

Interactive, or heads-up digitization, is one of the most common methods. In this method, you 

display an aerial photograph, satellite image, or orthophotograph on-screen as a basemap, then 

you draw features, such as roads, buildings, or parcels, on top of it. 

In hard-copy digitizing, you use a digitizing table connected to a computer that converts 

positions on the table surface into digital x,y coordinates as you trace them with a handheld 

puck (a pen or mouse like device). 

 

Automatic digitization is another method of digitizing features. The ArcScan for ArcGIS 

extension enables you to perform automatic or interactive raster-to-vector data conversion with 

high precision and little or no operator intervention during the data capture stage. 

Figure: Sketching a new polygon feature 
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Starting an Edit Session 

Editing occurs in an edit session. During an edit session, you can create or modify vector 

features or tabular attribute information. When you want to edit, you need to start an edit 

session, which you end when you're done. Editing applies to a single workspace in a single 

ArcMap data frame, where a workspace is a geodatabase or a folder of shapefiles. If you have 

more than one data frame in your map, you can only edit the layers in one data frame-even if 

all data is in the same workspace. Although you can edit data in different coordinate systems, 

it is generally best if all the data you plan to edit together has the same coordinate system as 

the data frame. 

 

Creating Features with Feature Templates 

 

Creating features is accomplished 

through the use of feature templates. 

Feature templates define all the 

information required to create a 

feature: the layer where a feature will 

be stored, the attributes a feature is 

created with, and the default tool used to 

create that feature. Templates also have 

a name, description, and tags that help 

you to find and organize them. If 

templates are not present when you start 

editing, they are automatically created 

for each layer in the current editing 

workspace. Templates are saved in map 

document (.mxd) and layer file (.lyr).  
 

 

A layer can have multiple templates associated with it, where each template has different 

default settings. For example, if you have a roads layer with classifications of freeway, major 

highway, and local road, you could have three different templates with each one having a 

different default attribute for the type of road. This makes it easier for you to create the new 

type of road you want from the start. To create a local road feature, simply click the local road 

template and new features are automatically created as a local road and attributed and 

symbolized properly. You still need to add other, nondefault attribute values after you create 

the feature. 

Using Snapping while Editing 

Snapping allows you to create features that connect to each other so that your edits are more 

accurate and have fewer errors. With snapping, your pointer will jump, or snap to, edges, 

vertices, and other geometric elements when it nears them. This enables you to position a 

Figure: Create new templates wizard 
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feature easily in relation to the locations of other features. As 

you move your pointer around the map, it snaps automatically 

to points, endpoints, vertices, and edges. All the settings you 

need to work with snapping are located on the Snapping 

toolbar, including enabling and disabling snapping types and 

setting snapping options. The main snap types are buttons on 

the toolbar, but additional ones are available on the Snapping 

menu. 

 

 
 

Creating Points 

Points are the simplest features to create. Simply click a point template in the Create Features 

window and the Point tool is automatically activated. Click the map where you want to add the 

point. You can right-click the map or use snapping to help you create points at exact locations. 

Creating Lines and Polygons (Segments) 

To create segments in lines or polygons, you will most commonly use the Line tool (with line 

templates) and the Polygon tool (with polygon templates). While these tools are used with 

different template types, they behave similarly. To create segments, simply click the map where 

you want to place vertices. 
 

Figure: Creation of points, line polygon 

Figure: Snapping tools 
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Creating Text Features 

You can store map text as annotation in a geodatabase. Annotation provides flexibility in the 

appearance and placement of your text because you can select individual pieces of text and edit 

them. Dimension features are a form of annotation designed to express distance measurements. 

Like other types of features, geodatabase annotation and dimension features are created inside 

an edit session, using feature templates and the tools on the Create Features window. 

Some annotation feature classes, such as standard annotation, stand alone in the geodatabase. 

Standard annotation is not formally associated with 

features in the geodatabase. For example, you might 

have a piece of standard annotation that represents a 

mountain range, an ocean, or an administrative 

boundary-the annotation simply marks the general area 

on the map. 

Another kind of annotation, feature-linked annotation, is 

associated with the feature it is describing through a 

relationship class. The text reflects the value of a field or fields from the feature to which it is 

linked. You might use feature-linked annotation to identify features such as parcels, streets, 

rivers, roads, or cities. With feature-linked annotation, as you create parcels or street features, 

for example, using the editing tools in ArcMap, annotation is created automatically. 

 

Defining New Types of Features to Create 

Sometimes, you may want to create features of a certain type in an existing layer, but the layer 

is not set up to capture those features. For example, you want to add features to a roads layer 

to represent an unpaved road, but you currently only have categories in your data for freeway, 

major highway, and local road. Through a 

wizard, you can define everything about the 

unpaved road category at one time—making 

it easy to prepare your data to display and 

store the new types of features. ArcMap 

automatically adds a symbol for the new 

category, any required geodatabase 

information (such as subtype value or coded 

domain value) for that layer, and a feature 

template to use when creating an unpaved 

road. The wizard saves you from having to 

stop your work to open multiple dialog   

      boxes to set up the data on your own. Figure: Define new feature type wizard 
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Editing existing features 

Once you have created features, you can also edit their shapes with the 

tools on the Editor Toolbar. For example, to split a polygon into two 

polygons, select the feature, click the Cut Polygons tool on the Editor 

Toolbar, then draw a line where you want to split the feature. To draw 

in a new shape for a line or polygon, select it, click the Reshape Feature 

tool on the Editor Toolbar, and sketch in how you want the feature to 

appear. 

 

Advanced Editing 

To use additional or more specialized editing tools, you must add other editing toolbars to 

ArcMap. These include Advanced Editing. 
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Working with Attribute Table 

Mustafa Atikul Mazid, 

Remote Sensing Analyst, Crop Zoning Project 

Bangladesh Agricultural Research Council 

Email: tushar060401@gmail.com 

 

Editing Attributes 

Attributes are descriptions of a geographic feature in a GIS, usually stored as a row in a table. 

For example, attributes of a river might include its name, length, and average depth. You can 

enter new attribute values when you create features, and you can edit existing values. When 

you create a feature, it starts with only the default attribute values as specified in the template 

used to create the feature. You input attributes after you create a feature. There are two main 

ways of adding or updating attributes in ArcMap: the Attributes window and the table window. 

 

Figure: Attribute window and table 
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Editing values in the table window 

Once you begin an edit session, you'll notice a pencil icon next to the Table Options button 

Table Options on the Table window, indicating that the table can be edited. In addition, those 

fields that you can edit will have a white background in the field heading. You can make any 

of the attribute changes you need by clicking a cell and typing a new attribute value. 
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Data Queries in GIS 

Abid Kamal 

GIS Analyst, Crop Zoning Project  

Bangladesh Agricultural Research Council 

Email: geoabid38@gmail.com 
 

In GIS, Data Queries help you select, filter, and analyze records based on attribute 

information. ArcMap uses a Structured Query Language (SQL)-like syntax for queries. 

Basic Query Logic 

Logical 

Operator 
Meaning Example Purpose 

AND 
Both conditions 

must be true 

District = 'Dhaka' AND 

Population > 500000 
Find areas in Dhaka with 

population > 500,000 

OR 
Either condition 

can be true 

District = 'Dhaka' OR 

District = 'Chittagong' 
Select features in either 

Dhaka or Chittagong 

LIKE 
Pattern matching 

(wildcards) 
District LIKE 'D%' Select districts starting 

with 'D' 

NOT 
Exclude specific 

values 
NOT District = 'Barisal' Select everything except 

Barisal 

IS NULL Field has no data Population IS NULL Find features with 

missing population data 

 

 

How to Perform a Query in ArcMap 

1. Open Attribute Table 

❖ Right-click the layer > Open 

Attribute Table. 

2. Select by Attributes 

❖ Click Table Options (top left) > 

Select by Attributes. 

3. Build Your Query 

❖ Double-click a field, select an 

operator, and type your value. 

❖ Example: 
City = 'Dhaka' AND 

Population > 1000000 
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4. Apply the Query 

❖ Click Apply or OK to see selected features highlighted. 
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Data Joining: Spatial Join and Attribute Join 

Abid Kamal 

GIS Analyst, Crop Zoning Project  

Bangladesh Agricultural Research Council 

Email: geoabid38@gmail.com 

 

ArcMap provides two primary methods for joining data: Attribute Join and Spatial Join. 

1. Attribute Join 

Purpose: Combine a table of data with spatial features based on a common attribute. 

Example Scenario: Joining a CSV file containing soil chemical data to a shapefile of 

districts using the 'TW_ID' field. 

Steps: 

1. Right-click on the target layer (e.g., 

Districts) in the Table of Contents. 

2. Select Joins and Relates > Join. 

3. In the Join Data dialog:  

o Choose Join attributes from 

a table. 

o Select the field in the layer 

that matches the field in the 

table. 

o Browse and select the table to 

join. 

o Choose the matching field in 

the table. 

4. Click OK. The attributes from the 

table are now associated with the 

spatial features. 
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2. Spatial Join 

Purpose: Combine attributes from one layer to another based on their spatial relationship. 

Example Scenario: Assigning the number of tubewells within each union. 

 

Steps: 

1. Right-click on the target layer (e.g., Union, Upazilla, District). 

2. Choose Joins and Relates > Join. 

3. In the Join Data dialog: 

o Select Join data from another layer based on spatial location. 

o Choose the layer to join (e.g., Tubewell, Schools, Farmers). 

o Specify the spatial relationship (e.g., features that intersect). 

4. Click OK. A new layer is created with combined attributes. 
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Basic Geoprocessing Tools 

Abid Kamal 

GIS Analyst, Crop Zoning Project  

Bangladesh Agricultural Research Council 

Email: geoabid38@gmail.com 
 

 

Step 1: Start ArcMap   

 

Step 2: Add data to ArcMap 

 

Add Road_bd.shp 

Add Barishal.shp 

 

Step 3: Clip Operation  

Road Clip by Barishal District 

Click on ArcToolbox button  

 

 

 

 

 

   ArcToolbox will appear. 

 

 

 

 

 

 

 

 

 

 

 

 

 

From ArcToolbox, Expand Analysis Tools > Extract > Double-click on Clip 

Clip Wizard will be displayed. 

Select as follows: 

Input features: Road_bd.shp 

Clip Features: Barishal.shp 

Output Feature Class: Road_Barishal.shp 

Click OK 

mailto:geoabid38@gmail.com
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Step 4: Buffer Operation 

 

Click on Geoprocessing menu > Buffer  

Buffer window will be opened. 

Select as follows: 

Input features: Road_Barishal.shp 

            Output Feature Class: Road_buff 

 Linear unit: 40 ft 

 Dissolve type: All 

 

Click OK   

 

Step 5: ‘Dissolve Feature’ Operation based on an Attributes 

 

Add mauza_Laksam_upz (mauza boundary of Laksam upazila) 

Right-Click on mauza_Laksam_upz > Zoom to Layer 

Click on Geoprocessing menu > Dissolve    

Dissolve window will be opened. 

 

Select as follows: 

Output Feature Class: Laksam_unions 

Check on UNINAME as Dissolve Fields 

 

Click OK 

 

Step 6: Intersect Operation 

 

Click on Insert Menu > Data Frame to create a new data frame 

 

A new blank data frame will be appeared. 

Add Union_Barishal.shp 

Add Road_Barishal.shp 

 

 

Click on Geoprocessing menu > Intersect   

Intersect window will be opened. 

Select Union_Barishal and Road_Barishal as input features 

 

Click OK 
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Basic Concepts of Remote Sensing Technology  

Hasan Mahmud, Senior System Analyst, Computer & GIS Unit  
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Email: hasan.mahmud@barc.gov.bd 

 

1. Introduction to Remote Sensing 

Remote sensing is the science of obtaining information about objects or areas from a distance, 

typically using satellite or aerial sensor technologies. It plays a crucial role in monitoring and 

managing natural resources, urban planning, agriculture, disaster response, and climate studies. 

The technology leverages electromagnetic radiation to gather data without direct contact with 

the subject.  

A formal definition: 

"Remote sensing is the science (and to some extent, art) of acquiring information about the 

Earth's surface without actually being in contact with it. This is done by sensing and recording 

reflected or emitted energy and processing, analyzing, and applying that information." 

2. Electromagnetic Spectrum and Radiation Principles 

Remote sensing relies on electromagnetic radiation (EMR), which is emitted or reflected by 

objects. The EM spectrum includes various wavelengths from gamma rays to radio waves. 

Different materials reflect, absorb, or emit EM radiation uniquely, allowing remote sensors to 

identify and analyze them through their spectral signatures. 
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3. Interactions with Atmosphere and Earth's Surface  

Before reaching sensors, radiation interacts with the atmosphere through scattering and 

absorption. Upon striking the Earth, radiation may be absorbed, transmitted, or reflected, 

depending on surface characteristics. Vegetation, water, and soil each exhibit distinct 

reflectance patterns across wavelengths. 

 

4. Remote Sensing Systems: Passive and Active 

Remote sensing systems can be classified as passive or active. Passive systems detect natural 

energy (typically from the sun) reflected by the surface, while active systems emit their own 

signal and measure its reflection. Examples include optical sensors (passive) and radar 

systems (active). 

 

 

5. Types of Resolutions 

Resolution in remote sensing defines the 

level of detail. The four primary types are: 
 

Spatial: Size of the smallest object     

detectable. 
 

Spectral: Number and width of spectral   

bands. 
 

Temporal: Frequency of data acquisition. 
 

 

Radiometric: Sensitivity to differences in signal strength. Represented as how many bits are used to 

represent a reflectance value. 
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6. Satellites, Orbits, and Sensors 

Satellites operate in various orbits - geostationary, polar, or sun-synchronous - each serving different 

observation purposes. Sensors onboard these satellites, such as MODIS, Landsat OLI, and Sentinel-1 

SAR, differ in design and application. Key satellite parameters include orbit type, swath width, and 

revisit time. 
 

Parameter Sentinel-1 Sentinel-2 Landsat-8 Landsat-9 
MODIS 

(Terra/Aqua) 

Orbit Sun-synchronous, Near-polar 

Altitude ~693 km ~786 km ~705 km ~705 km ~705 km 

Repeat 

Cycle 

12 days 

(6 days 

A+B) 

10 days (5 

days A+B) 
16 days 

16 days (8 

days 

Landsat-8) 

1-2 days (near-

global daily) 

Sensor C-SAR MSI 
OLI & 

TIRS 

OLI-2 & 

TIRS-2 
MODIS 

Resolution 5-20 m 
10 m, 20 m, 

60 m 

15 m (pan), 30 m (MS), 

100 m (Thermal) 

250 m, 500 m,  

1 km 

Swath 

Width 
80-400 km 290 km 185 km 185 km 2330 km 

Spectral 

Bands 

HH, VV, 

HV, VH 
13 

9 (Vis, NIR, SWIR, Pan) 

+ 2 (Thermal) 

36 

(Visible to 

Thermal IR) 

Data Type 

Radar 

Backscatter 

(Intensity 

& Phase) 

TOA 

Reflectance 

TOA Reflectance, 

Thermal Radiance 

Radiance, 

Reflectance, 

Temperature, 

Indices, etc. 
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7. Data Processing Levels 

Satellite data is processed in levels: 

      - Level 0/1: Raw Sensor Data. 

      - Level 2: Geophysical Variables (e.g., surface temperature). 

      - Level 3: Gridded, Calibrated data, Quality Controlled Data. 

      - Level 4: Model-assimilated products. 

 

8. Optical Vs Radar 

 

 

Feature Optical Imagery Radar Imagery (SAR) 

Sensor Type 
Passive (detects reflected/emitted 

light) 

Active (emits and receives 

microwaves) 

Illumination Sun (mostly), thermal emission Self-illuminated (microwaves) 

Weather Affected by clouds, fog, smoke Can penetrate clouds, fog, smoke 

Day/Night Primarily daytime Day and night 

Penetration Limited 
Can penetrate vegetation, some 

ground 

Data 

Captured 

Spectral reflectance (color, 

vegetation health, composition) 

Surface roughness, dielectric 

properties, geometry 

Image Look Visually intuitive (photo-like) 
Grayscale, textural, requires 

specific interpretation 

Resolution Can be very high High (with SAR processing) 
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9. Important Indices 

NDVI, NDWI, NDSI, and EVI are key vegetation and land surface indices derived from 

multispectral satellite data. NDVI uses red and NIR bands to assess vegetation greenness, while 

NDWI (using NIR and SWIR) monitors vegetation water content and open water. NDSI (using 

green and SWIR) is designed for snow detection. EVI is an enhanced vegetation index utilizing 

blue, red, and NIR bands to minimize atmospheric and soil noise and reduce saturation in dense 

vegetation, offering a more robust measure compared to NDVI in certain environments. The 

Leaf Area Index (LAI) is a crucial biophysical parameter that quantifies the amount of leaf 

material present in a plant canopy or ecosystem. Defined as one-half of the total green leaf area 

per unit horizontal ground surface area (for broadleaf canopies) or a related measure for 

coniferous canopies. Each index provides specific insights into surface characteristics but has 

limitations related to atmospheric conditions, background influences, and the specific 

properties they aim to measure. 

 

NDVI = (NIR - Red) / (NIR + Red)  

NDWI (Common) = (NIR - SWIR) / (NIR + SWIR)  

NDSI = (Green - SWIR) / (Green + SWIR)  

EVI = G * ((NIR - Red) / (NIR + C1 * Red - C2 * Blue + L))  

(where G, C1, C2, and L are adjustment factors) 

 

 

10. Advantages and Challenges 
 

Advantages: 

- Provides data where ground access is limited 

- Offers global coverage and consistent observations 

- Supports real-time and historical analysis 

- Information on non-visible regions of the spectrum 

Challenges: 

      -    Balancing resolution parameters 

      -    Data volume and complexity 

      -    Need for calibration and validation 

      -    Costly high resolution Imagery 

 

References: 

❖ NASA’s Applied Remote Sensing Training Program 

❖ Canada Centre for Remote Sensing Remote Sensing Tutorial 

❖ Tutorial by TELECAN on Fundamentals of Remote Sensing 
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A Simple Illustration of Bands (Practical) 

In this exercise we will check how do the individual channels/bands (RGB) looks that are 

present in our standard jpg, png images.  

 

 

All 3 Channels Composite 

 

 

 

Only Red Channel 
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Only Green Channel 

 

 
 

Only Blue Channel 

 

For True Color Composite:   

Red => Band_1 

Green => Band_2 

Blue => Band_3 

 

Try assigning any others bands (except Band-1) to Red channel. Observe the effects. 

This is the foundation of false-color composite. 
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Introduction to LiDAR Remote Sensing 

Dr. Md. Golam Mahboob, PSO (Forestry), NRM Division 

Bangladesh Agricultural Research Council 
Email: golam.mahboob@barc.gov.bd 

 

Overview 

 

LiDAR (Light Detection And Ranging) is a remote sensing technology that uses laser pulses 

to measure distances and create precise 3D representations of the Earth's surface. It is widely 

used in forestry, agriculture, environmental monitoring, urban planning, and geological studies. 

 

   
 

 

 

Principles of LiDAR 

 

The basic principle of laser ranging is the measurement of the time it takes for a laser signal to 

travel from the transmitter to the reflecting surface of a target and back to the receiver. 

 

 𝐷 = 𝑐 ×
𝑡

2
  

     

Here,  D is the measured distance 

            c is the speed of light (3×108 m/s) 

 t is the pulse travel time 

 

Types of LiDAR  

  

Figure-1: LiDAR Data Acquisition Figure- 2: 3D Point Cloud 

 

Figure-3: LiDAR Measurement 

 Satellite LiDAR 

    Used in global mapping applications. 

 
 Airborne LiDAR 

    Mounted on aircraft or drones to map  

    large areas. 

 
 

 Terrestrial LiDAR 

    Fixed or mobile ground-based systems  

    for detailed mapping. 

 

Figure-4: Types of LiDAR 
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Components of LiDAR System 

 Laser Scanner 

    Emits laser pulses 

 Laser receiver 

    Records reflected energy 

 GNSS Receiver: 

    Provides positional accuracy 

 Inertial Measurement Unit (IMU) 

    Tracks movement and orientation. 

 High-precision clock 

    Synchronizes all sensors  

 Onboard software 

    Manage systems and store data  

 Optical/infra-red camera  

    Optional, for photograph or video capture 

 

Applications in Environmental Science 

Forestry: Measuring tree height, biomass estimation, and canopy structure analysis. 

Agriculture: Precision farming and land-use classification. 

Hydrology: Monitoring water flow, flood modeling, and watershed management. 

Geology: Terrain mapping, fault detection, and slope stability assessment. 

 

Advantages of LiDAR 

✔ High spatial accuracy  

✔ Rapid data acquisition  

✔ Works in varying light conditions  

✔ Suitable for large-scale mapping 
 

Limitations 

    High cost of equipment  

    Requires specialized data processing skills  

    Laser penetration affected by water bodies 
 

Prospects 

LiDAR technology is advancing with improved sensors, AI-driven data processing, and 

integration with satellite imaging for enhanced environmental analysis. 
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Applications of LiDAR Remote Sensing in Natural 

Resources Management 

Dr. Md. Golam Mahboob, PSO (Forestry), NRM Division  

Bangladesh Agricultural Research Council 
Email: golam.mahboob@barc.gov.bd 

 

 

1. Introduction to LiDAR Remote Sensing 

LiDAR (Light Detection and Ranging) is an advanced remote sensing technology that uses 

laser pulses to measure distances and generate high-resolution 3D representations of the Earth's 

surface. It is widely used in natural resources management due to its ability to provide precise 

and detailed spatial data. 

Key Features of LiDAR: 

 High-resolution topographic mapping 

 Ability to penetrate vegetation canopy 

 Precise elevation measurements 

 Generation of 3D models for environmental analysis 

2. Applications in Forestry Management 

LiDAR plays a crucial role in forestry by offering detailed insights into forest structure, health, 

and biomass estimation. 

Forestry Applications: 

 Tree Height & Density Mapping 

Helps estimate forest canopy height and tree distribution. 

 Biomass & Carbon Stock Assessment 

Measures forest biomass for carbon sequestration studies. 

 Forest Inventory & Species Classification 

Identifies tree species and assesses forest composition. 

 Deforestation & Habitat Monitoring 

Tracks forest loss and its impact on biodiversity. 

 
 

Figure-1: Forest Biomass Mapping from LiDAR Data 

mailto:golam.mahboob@barc.gov.bd
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3. Applications in Watershed & Hydrology Management 

LiDAR data significantly enhances hydrological studies by improving terrain analysis and 

flood modeling. 

Hydrological Applications 

 Watershed Delineation 

Defines drainage basins and water flow paths. 

 Flood Risk Assessment  

Creates accurate floodplain maps for disaster preparedness. 

 Riparian Zone Analysis 

Identifies vegetation along rivers, improving conservation planning. 

 Groundwater & Surface Water Interaction Studies 

Assists in evaluating water movement and storage. 

 
 

4. Applications in Agriculture & Land Use Planning 

LiDAR supports precision agriculture and sustainable land use management. 

 

Agricultural Applications: 

 Soil Erosion & Terrain Mapping 

Assesses landforms to mitigate soil degradation. 

 Crop Health & Yield Prediction 

Analyzes plant growth patterns for precision farming. 

 Irrigation Planning 

Optimizes water distribution based on terrain slope and elevation. 

 Land Use Classification 

Differentiates agricultural, urban, and natural landscapes. 
 

 

 

 

 

 

 

Figure-2: Urban Flood Hazard Maps, doi: https://doi.org/10.3390/w11091832   

Figure-3: a. LiDAR Scanner, b. Mobile LiDAR System, c. Collected Point Clouds from Crop Field 

https://doi.org/10.3390/w11091832
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5. Applications in Biodiversity & Wildlife Conservation 

LiDAR contributes to ecological studies by enhancing habitat mapping and species monitoring. 

 

Conservation Applications: 

 Habitat Suitability Analysis 

Identifies critical habitats for endangered species. 

 Vegetation Structure Assessment 

Evaluates forest canopy for biodiversity conservation. 

 Wildlife Corridor Planning 

Supports strategic conservation for species movement. 

 Mapping Invasive Species Spread 

Detects vegetation changes to manage invasive species. 
 

 
 

 
 

 

6. Future Prospects & Emerging Applications 

 Integration with AI & Machine Learning 

Enhances automated feature detection. 

 LiDAR for Coastal & Marine Studies 

Expands applications to underwater ecosystems. 

 Advancements in Drone-Based LiDAR 

Increases accessibility for localized monitoring. 

 Climate Change Impact Studies 

Supports long-term environmental assessments. 

 

Conclusion: 

LiDAR remote sensing is revolutionizing natural resources management by providing high-

precision data for environmental monitoring, conservation, and sustainable development. Its 

integration with GIS and AI offers promising advancements for future applications. 

Figure-4: Habitat suitability maps for red tree voles derived from airborne LiDAR at 

(A) full (10.36 pulses/m2 ) and reduced point densities of (B) 4 points/m2 and 

(C) 1 point/m2 in southwestern Oregon, USA, doi: 10.1002/jwmg.21173  

https://doi.org/10.1002/jwmg.21173
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Open-Source Satellite Imagery 

Md. Zohir Uddin Omor 

Manager, GIS & IM, Care Bangladesh 

Email: zohiruddin.omor@care.org 
 

There are several open-source and publicly available satellite imagery sources that provide 

coverage of Bangladesh. These are useful for monitoring agriculture, urban growth, flooding, 

deforestation, and more. Here's a list of some of the best platforms and datasets: 

1. Sentinel Hub (European Space Agency - ESA) 

• Satellites: Sentinel-1 (radar), Sentinel-2 (optical) 

• Resolution: 10–20 meters (Sentinel-2), all-weather radar (Sentinel-1) 

• Update frequency: Every 5 days (Sentinel-2) 

• Use cases: Land use, vegetation, flood mapping 

• Access: https://apps.sentinel-hub.com/eo-browser 
 

2. NASA Earthdata (via LP DAAC and Earthdata Search) 

• Satellites: MODIS (Terra & Aqua), Landsat, VIIRS 

• Resolution: 

MODIS: 250m–1km (daily) 

Landsat: 30 meters (16-day revisit) 

• Use cases: Climate monitoring, long-term land change 

• Access: https://search.earthdata.nasa.gov/  

 

3. USGS Earth Explorer 

• Satellites: Landsat series, Sentinel-2, others 

• Resolution: 30 meters (Landsat), 10 meters (Sentinel-2) 

• Use cases: Historical land cover change, hydrology, urban planning 

• Access: https://earthexplorer.usgs.gov/  
 

4. Google Earth Engine (GEE) 

• Type: Cloud-based geospatial processing 

• Data: Landsat, Sentinel, MODIS, many more 

• Use cases: Custom time-series analysis, deforestation, flood mapping 

• Access: https://earthengine.google.com/  

Note: Requires an application for access (free for research, NGOs, and developers) 

 

5. OpenAerialMap 

• Type: Open aerial imagery contributed by users and organizations 

• Use cases: Post-disaster mapping, infrastructure 

• Access: https://openaerialmap.org/  

mailto:zohiruddin.omor@care.org
https://apps.sentinel-hub.com/eo-browser
https://search.earthdata.nasa.gov/
https://earthexplorer.usgs.gov/
https://earthengine.google.com/
https://openaerialmap.org/
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6. Radiant Earth Foundation 

• Type: Open ML-ready earth observation data 

• Use cases: Agriculture, humanitarian response, ML models 

• Access: https://radiant.earth/  

Steps to download sentinel 2 data from Copernicus Sentinel Hub 

To download Sentinel-2 data from the Copernicus Sentinel Hub (ESA), you can follow these 

steps. There are two main ways: via the EO Browser (user-friendly interface) 

Open EO Browser: 

Create a (Free) Account: 

• Click “Log in” or “Sign up” (free for public and research use). 

• You need an account to download high-resolution imagery. 

 

Select Area of Interest (AOI): 

• Use the search bar or draw a polygon/rectangle on the map to define your area. 

 

 

 

https://radiant.earth/
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Select Satellite and Data Source: 

• Choose Sentinel-2 L1C (Top-of-atmosphere reflectance) 

• Or Sentinel-2 L2A (Surface reflectance, atmospherically corrected) 

 

Choose Time Range: 

• Select a date range in the top-left panel to filter available scenes. 

 

 

Browse and Preview Data: 

• Click on a result to preview the scene. 

• Use the drop-down to choose band composites (e.g., True color, NDVI, etc.) 
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Download the Image: 

• Click "Download" (bottom right). 

• Set resolution and bands to export (e.g., B2, B3, B4, B8) 
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Layer Stack/Composite Bands of Satellite Image 

Md. Zohir Uddin Omor 

Manager, GIS & IM, Care Bangladesh 

Email: zohiruddin.omor@care.org 

 

Composite bands in satellite imagery refer to combining multiple spectral bands (channels) 

into a single image to highlight specific features or patterns on Earth's surface. Different band 

combinations (also called "band composites") are used to visualize and analyze different land 

cover types, vegetation, water bodies, urban areas, etc. 

Common Types of Band Composites 

1. True Color Composite 

• Bands Used (e.g., Sentinel-2): Red (B4), Green (B3), Blue (B2) 

• What It Shows: Similar to what the human eye sees 

• Use Case: General visualization, urban mapping 

 

2. False Color (Infrared) Composite 

• Bands Used: NIR (B8), Red (B4), Green (B3) 

• What It Shows: Vegetation appears red; healthy vegetation is very bright 

• Use Case: Vegetation health, crop analysis 

 

3. Shortwave Infrared (SWIR) Composite 

• Bands Used: SWIR1 (B11), NIR (B8), Red (B4) 

• What It Shows: Useful for distinguishing water, snow, burn scars, and soil moisture 

• Use Case: Flood detection, burn area mapping 

 

4. Urban/Man-Made Feature Composite 

• Bands Used: SWIR (B12), NIR (B8A), Red (B4) 

• What It Shows: Enhances man-made structures; urban areas appear distinct 

• Use Case: Urban growth monitoring 

 

 

 

 

mailto:zohiruddin.omor@care.org
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Composite Bands in ArcMap 10.8 

Creates a single raster dataset from multiple bands. 

 
                                               Source: ESRI 

Usage 

• This tool can also create a raster dataset containing subset of the original raster dataset 

bands. This is useful if you need to create a new raster dataset with a specific band 

combination and order. 

• The order that the bands are listed in the Multi-value Input control box will determine 

the order of the bands in the output raster dataset. 

• This tool can only output a square cell size. 

• You can save your output to BIL, BIP, BMP, BSQ, DAT, Esri Grid , GIF, IMG, JPEG, 

JPEG 2000, PNG, TIFF, MRF, CRF, or any geodatabase raster dataset. 

• The output raster dataset takes the cell size from the first raster band in the list. 

• By default, the output raster dataset takes the extent and the spatial reference of the first 

raster band with a spatial reference in the list. You can change this by setting the output 

extent and output coordinate system in the Environment Settings. 

• The following are some examples of why you would want to combine single raster 

datasets into multiband raster datasets:  
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✓ You may have received some satellite data where each band of data is contained in 

a single file—for example, band1.tif, band2.tif, and band3.tif. To render these raster 

datasets together to create a color composite, each band needs to be contained within 

a single raster dataset (for example, allbands.tif). 

✓ You may have several raster datasets of the same area captured at various times. By 

displaying these raster datasets as a color composite, you can detect change in the 

area, such as urban growth or cut forests. To create this color composite, each raster 

dataset needs to be contained as individual bands within a single raster dataset. 

✓ In some cases, the output of an analysis operation is a single-band raster dataset. To 

do further visual analysis, you may need to combine the outputs by rendering your 

data as a color composite. 

✓ Combining bands into one raster dataset can help you organize many related single-

band rasters. 

 

Example Steps by Steps 

A multiband raster from Landsat 8 band images can be created in ArcMap, either by using the 

Composite Bands (Data Management) tool or the Composite Bands button in the Image 

Analysis window. 

 

The instructions provided describe how to create a multiband raster from Landsat 8 band 

images. 

Option A: 

 

Use the Composite Bands (Data Management) tool. 

 

1. In ArcMap, navigate to Geoprocessing > ArcToolbox > Data Management Tools > Raster 

> Raster Processing > Composite Bands. 

2. Click the browse button, and search for the desired input raster. 

 

 

3. Specify the name and location of the output raster, and click OK. 
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Note: 

 If working outside a geodatabase, specify the extension of the output raster.  

 

 

Option B: 

 

Use the Composite Bands button in the Image 

Analysis window. 

 

1. In ArcMap, add the raster bands to 

the map document. 

2. Navigate to Windows > Image 

Analysis. 

3. In the Image Analysis window, hold 

down the shift key and select the 

band images. 

4. Click the Composite Bands button. 

 

 

Note: 

The output of the Image Analysis window is added to the map document as a temporary layer. 

To save the output layer as a raster dataset, click the Export button on the Image Analysis 

window and specify the output location of the raster dataset.  
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Note: 

The output raster of both options is generated as an RGB composite. To change it to a Stretched 

value composite, right-click the layer > Properties > Symbology. Under the Show section, 

select the 'Stretched' option, and specify the band to be used for the stretch values. Input the 

desired parameters, and click OK.  
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Satellite Image Processing 

Md. Zohir Uddin Omor 

Manager, GIS & IM, Care Bangladesh 

Email: zohiruddin.omor@care.org 
 

 

Satellite Image Processing 

Satellite image processing involves analyzing and interpreting data captured by satellites to extract 

meaningful information. This field combines remote sensing, computer vision, and image processing 

techniques to monitor and manage natural and man-made environments. 

1. Key Steps in Satellite Image Processing: 

1. Image Acquisition 

o Obtaining images from satellite sensors (e.g., Landsat, Sentinel, MODIS). 

o Images may come in various bands (visible, infrared, thermal, etc.). 

2. Preprocessing 

o Radiometric Correction: Adjusting pixel values to account for sensor noise and 

lighting. 

o Geometric Correction: Aligning images to a known coordinate system. 

o Atmospheric Correction: Removing atmospheric effects like haze or clouds. 

o Resampling: Adjusting image resolution or grid alignment. 

3. Image Enhancement 

o Contrast stretching, filtering, and edge enhancement to improve visual 

interpretability. 

4. Image Classification 

o Supervised (e.g., SVM, Random Forest, CNN): Uses labeled training data. 

o Unsupervised (e.g., K-means, ISODATA): Clusters based on pixel similarities. 

5. Change Detection 

o Comparing images from different time periods to detect environmental or structural 

changes. 

6. Feature Extraction 

o Identifying objects like roads, buildings, vegetation, or water bodies using pattern 

recognition or deep learning. 

7. Analysis and Visualization 

o Using GIS software (like QGIS, ArcGIS) or programming tools (Python, MATLAB) 

to interpret results and create visual outputs. 

 

Tools and Libraries: 

• Software: ENVI, ERDAS Imagine, SNAP (for Sentinel), QGIS, ArcGIS 

• Programming Libraries: 

o Python: rasterio, gdal, numpy, scikit-image, opencv, tensorflow, pytorch, earthpy 

o R: raster, rgdal, sf, terra 

 

2. Satellite Image Processing in ArcGIS 

Imagery is processed and used for a wide variety of geospatial applications, including geographic 

context, visualization, and analysis. You may want to apply processing techniques on image data, 

visually interpret the data, use it as a background to aid interpretation of other data, or use it for analysis. 

In this course, you will use tools in ArcGIS to perform basic image processing. You will learn how to 

dynamically modify properties that enhance image display, visualize surface features, and create 

multiple products. 

 

mailto:zohiruddin.omor@care.org


61 | P a g e   

The role of imagery in GIS 

Images and rasters are used in ArcGIS for various reasons: 

• As background to provide reference to geographic data 

• For heads-up digitizing while editing 

• For visually interpreting a site 

• For advanced analysis 

 

Image processing allows you to see information about your data that would have been otherwise 

difficult to extract. Imagery and raster data are integrated into all aspects of ArcGIS. Imagery can be 

used to enhance other geographic data or to provide reference in editing, or it can be processed to 

provide powerful data that is necessary for answering complex analysis questions. 

 

 

  

 

What is image processing? 

How would you identify where healthy vegetation is growing in a city? How can you combine bands 

to visualize imagery in natural color? Can you combine a low-resolution natural color image and a high-

resolution grayscale image in a single image? Image processing can help you answer questions like 

these. 

Types of image processing 

ArcGIS provides many options for image processing. The image-processing techniques described in 

this graphic allow you to use ArcGIS to extract answers from imagery for analysis. 
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Accessing and enhancing imagery 

You can employ numerous types of image formats 

in ArcGIS for display purposes. Several of these 

format types can be used for image processing. It 

is important to know about these formats - and to 

understand which image-processing operations 

you can perform on them -before you start your 

analysis. 

You can also enhance imagery for visual 

interpretation. Knowing which options you can use 

to change and improve the display can help answer 

questions about your data. 

 

Common imagery types used in processing 

Image processing can be applied to a variety of raster types. This graphic illustrates three commonly 

used types: aerial imagery, satellite imagery, and elevation data. 

   

Aerial images are photographs 

of the earth's surface, usually 

taken from an aircraft using 

film or digital camera. These 

images are often used for 

image-processing functions 

like pan-sharpening, NDVI, 

and composite. 

Satellite images often consist of 

multiple spectral bands, some of 

which are invisible (such as 

infrared). In this Landsat 7 

image, bands 5, 4, and 1 are 

represented. A Landsat is an 

earth-orbiting satellite that 

gathers imagery for land-use 

inventory, geological 

exploration, crop assessment, 

and similar activities. Satellite 

images can be subjected to a 

variety of image-processing 

functions (pan-sharpening, 

NDVI, and composite etc.). 

Elevation data represents the 

ground (bare earth) or surface 

of the earth (including 

buildings and other structures). 

This image is a digital 

elevation model (DEM) 

representing the earth's 

surface. A common image-

processing function applied to 

elevation data is hillshade. 

Here, the result is a tinted 

hillshade. 
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Enhancing Image Display 

Changing display properties can enhance an image to either prepare it for additional processing or 

answer questions about your data through visual interpretation. You can easily access these display 

options through the Image Analysis window and apply them on the fly to avoid altering the original 

image. 

  

The contrast slider adjusts the displayed contrast 

characteristics of the selected image. The image on 

the right has been enhanced to increase contrast. 

The brightness slider adjusts the displayed 

brightness characteristics of the selected image. 

The image on the right has been enhanced to 

increase brightness. 

 

  

The transparency slider adjusts the transparency of 

the selected image, allowing for visualization of 

data under the image. The image on the right has 

been made partially transparent to allow the 

hillshade image (another image below the green 

image) to show through. 

 

The gamma slider adjusts the gamma 

transformation of the selected image. The 

gamma refers to the degree of contrast between 

the mid-level gray values of a raster dataset. 

Gamma does not affect the black or white values 

in a raster dataset, only the middle values. The 

image on the left has 0, whereas the image on 

the right has .48 applied. 
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The DRA check box refers to "dynamic range 

adjustment." This allows the brightness and 

contrast of the image display to be adjusted based 

only on the data and contained within the data 

frame extent. That means dark areas will 

automatically brighten, and bright areas will 

automatically darken. The image on the left does 

not have the option checked, whereas the image on 

the right does. 

 

The stretch adjusts the stretch applied to the 

selected image. There are six stretch options 

available: None, Minimum-maximum (Min-

max), Standard deviation (Std-dev), Histogram 

equalization (Hist-eq), Percent clip, and Esri. 

Different stretches will produce different results 

in the raster display. The image on the left has 

no stretch applied (None), whereas the image on 

the right has standard deviation (Std-dev). 

 

 

 

The resample selection chooses which resampling 

method to apply when you pan and zoom to view 

the selected image. Resampling is the process of 

interpolating the pixel values to fit your raster 

dataset to the desired resolution. Resampling 

methods include nearest neighbor, bilinear, cubic 

convolution, and majority. 
 

 

Common Image Processing Techniques 

Image processing can make imagery more useful and informative. Using image-processing techniques 

allows you to extract information for use in analysis. ArcGIS offers many options for image processing. 

Now, you will learn about four specific examples of image-processing functions: hillshade, composite, 

NDVI, and pan-sharpening. 

Image Classification 

Image Classification in remote sensing is the process of assigning land cover or land use classes (e.g., 

water, vegetation, urban) to each pixel in a satellite image based on its spectral characteristics. Image 

classification refers to the task of extracting information classes from a multiband raster image. The 

resulting raster from image classification can be used to create thematic maps. Depending on the 
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interaction between the analyst and the computer during classification, there are two types of 

classification: supervised and unsupervised. 

With the ArcGIS Spatial Analyst extension, there is a full suite of tools in the Multivariate toolset to 

perform supervised and unsupervised classification (see An overview of the Multivariate toolset). The 

classification process is a multi-step workflow, therefore, the Image Classification toolbar has been 

developed to provided an integrated environment to perform classifications with the tools. Not only 

does the toolbar help with the workflow for performing unsupervised and supervised classification, it 

also contains additional functionality for analyzing input data, creating training samples and signature 

files, and determining the quality of the training samples and signature files. The recommended way to 

perform classification and multivariate analysis is through the Image Classification toolbar. 

 

Supervised Classification 

Supervised classification uses the spectral signatures obtained from training samples to classify an 

image. With the assistance of the Image Classification toolbar, you can easily create training samples 

to represent the classes you want to extract. You can also easily create a signature file from the training 

samples, which is then used by the multivariate classification tools to classify the image. 

 

Unsupervised Classification 

Unsupervised classification finds spectral classes (or clusters) in a multiband image without the 

analyst’s intervention. The Image Classification toolbar aids in unsupervised classification by providing 

access to the tools to create the clusters, capability to analyze the quality of the clusters, and access to 

classification tools. 

 

Example 

In the following example, the Image Classification toolbar was used to classify a Landsat TM satellite 

image. 

The following raw satellite image is a four-band Landsat TM image of the northern area of Cincinnati, 

Ohio. 

 
Input Landsat TM image 

Using the toolbar, five land-use classes were defined from the satellite 

image: Commercial/Industrial, Residential, Cropland, Forest, and Pasture. 
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Training Samples 

 

The quality of the training samples was analyzed using the training sample evaluation tools 

in Training Sample Manager. 

 
Evaluating Training Samples                                                                                                          

Using the Image Classification toolbar and Training 

Sample Manager, it was determined the training samples 

were representative for the area and statistically separate. 

Therefore, a maximum likelihood classification was 

performed from the toolbar. The classified image was then 

cleaned to create the final land-use map as shown below. 

 

Output Classified Land Use Map 

Change Detection 

Temporal change detection can be performed by comparing 

two rasters from a different time, such as detecting changes 

in vegetation cover, or land use over a specified period. This 

can be done with the Raster Calculator in ArcMap, which 

gives results that allow further interpretation and 

classification for quantifying areas of change. 
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The images below show vegetation cover for years 2005 and 2017. The instructions provided describe 

how to detect and quantify vegetation cover changes from 2005 to 2017 using the Raster Calculator 

tool. 

 
 

Procedure 

1. Subtract NDVI rasters for the difference in pixel values over time. 

Note:  

The NDVI rasters must cover the same spatial extent, and the pixels must be perfectly aligned. 

Additionally, to detect annual changes, acquire NDVI rasters calculated for the same window 

of the year. Otherwise, NDVI rasters calculated in different seasons reflect vegetation changes 

over seasons, and not years. 

a. Navigate to Spatial Analyst Tools > Map Algebra > Raster Calculator. 

b. In the Raster Calculator dialog box, type the expression required to subtract the raster of a 

previous time from the raster of a later time. For example: 

 

 
c. Set a name and location for the Output raster. 

d. Click OK. The output raster contains the subtracted cell values. Negative values indicate 

losses while positive values indicate gain. Zero '0' indicates unchanged vegetation cover. 
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2. The raster generated in Step 1 can be classified into multiple classes to reflect vegetation 

change direction and extent. For example, (a) Vegetation loss; (b) No change, and (c) 

Vegetation gain, or (a) Significant loss; (b) Loss; (c) No change; (d) Gain, and (e) Significant 

gain. 

a. Navigate to Spatial Analyst Tools > Reclass > Reclassify. 

b. Select the output raster from Step 1 for Input raster. 

c. Select VALUE for Reclass field. 

d. Under Reclassification, click Classify.... 

 

 
 

e. In the Classification dialog box, select a method for the classification in the Method drop-

down list, and select the desired number of classes in the Classes drop-down list. 

f. Set the Break Values manually, if necessary. 
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g. Click OK to exit the Classification dialog box. 

h. In the Reclassify dialog box, set a name and location for Output raster. 

i. Click OK. A reclassified raster is generated with pixel values indicating the vegetation 

change classes. A Count field is added to the attribute table of the reclassified raster 

containing the number of cells falling into each class. 

 

 
 

3. Quantify the changes by creating a new field, and calculate the area of each class by 

multiplying the Count field with the pixel size of the raster layer. 

a. Open the attribute table of the output in Step 2. Right-click the layer and click Open 

Attribute Table. 

b. Click Table Options > Add Field. 

c. In the Add Field dialog box, type a name for the new field. Select Double as the field 

type. Leave other settings at default, and click OK. 

d. Right-click the new field > Field Calculator. Click Yes if a prompt dialog displays. 

e. In the Field Calculator dialog box, multiply the Count field by the pixel size of the 

raster layer. For example, this raster's pixel size is 90. 
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f. Click OK. The area for each class is calculated in the new field. The unit of the calculated 

area is the unit of the raster's coordinate system. 
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GIS Visualization and Map Layout  

Hasan Mahmud, Senior System Analyst, Computer & GIS Unit  

Bangladesh Agricultural Research Council 

Email: hasan.mahmud@barc.gov.bd 

 
A page layout (often referred to as a layout) is a collection of map elements organized on a 

virtual page, designed for map printing. Common map elements that are arranged in the layout 

include one or more data frames (each containing an ordered set of map layers), a scale bar, 

north arrow, map title, descriptive text, and a symbol legend. 

 

FIGURE: KEY ELEMENTS OF THE PAGE LAYOUT USER INTERFACE 

In Layout view we can add map elements such as north arrows, legends, and scale bars, as well 

as, frames that contain the geographic data or the maps themselves. Other finishing touches can 

be added to a Layout using a full suite of graphics and graphic editing tools. Rulers 

mailto:hasan.mahmud@barc.gov.bd
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and guides can be used in the Layout View to help accurately measure and organize the 

elements on the page. What we see on the layout is what we get if we print or export the map to 

the same page size. 

Creating a New Page Layout 

The first step in ArcMap is to change your map view to layout—either by selecting Layout 

View from the View menu or by clicking the Layout View button on the lower left of the map 

display 
 

In order to save time, we may want to consider using a template to preconfigure your layout. 

When starting a new document, we can use one of the templates included with ArcMap or 

create your own. 
 

 
FIGURE: LAYOUT TEMPLATES 

Using a template is optional.  

Once we are working in layout view, we can set up your page orientation and dimensions using 

the Page and Print Setup dialog box. 

When we create a new document from a template, an untitled map is opened based on the 

selected template. These templates are listed under the My Templates node under New Maps. 
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Figure: Open existing maps or create new 

 
The Select Template dialog box 

User and system templates are also available when changing your page layout in the Select 

Template dialog box. New templates are available in the Select Template dialog box from the 

same user profile and system location used by the Getting Started dialog box. 
 

Figure: Change page layout with a user-defined template under  

             My Templates or a  system template from Templates
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Change your page layout with a user-defined template under My Templates or a system 

template from Templates. 

To open the Select Template dialog box, click the Change Layout button    on 

the Layout toolbar. 

 

Adding a data frame to the page layout 

The data frame displays a collection of layers drawn in a particular order for a given map extent 

and map projection. We can add a data frame to the page layout using the Insert menu. 
 

From this menu, we can insert additional data frames. These additional data frames may be for 

locator or detail maps. If we are using multiple data frames we may want to consider using extent 

indicators to show the extent of one data frame within another data frame. A good locator map 

will also contain an indicator, such as an outline, showing where the extent of the detail map 

fits within a larger extent. For example, your locator map might show the location of a state 

within a country. 

When your map document contains more than one data frame, only one will be the active data 

frame, that is, the one with which we are actively working. The active data frame name is 

shown in bold in the table of contents and the frame will be highlighted on the page with a 

dashed outline. To make a data frame active, right-click on its name in the table of contents 

and select Activate or single-click the data frame on the page layout. 

Adding Other Map Elements to Page Layout 

Use the Insert menu to select other map elements to add to your layout. We can use this menu 

to add a Title to the page. The added text will be the same as the text entered for the title in the 

Map Document Properties dialog box. Along with a title we can add (static) Text and Dynamic 

Text. 
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We can use the Insert menu to add a Legend, North Arrow, Scale Bar, and Scale Text. Clicking any 

of these options opens an appropriate wizard or dialog box where we can set properties for each 

map element. 
 

We can also add Neatlines, pictures, and objects from the Insert menu. 
 

The Draw toolbar can be used to add graphic shapes such as rectangles, lines, and points. We can 

also add graphic text and edit text properties. 
 

 

 

Working with Map Elements 

As we add map elements, we can 

edit their properties, size, 

position, and appearance, and 

arrange them on the page with 

other map elements. From the 

View menu we can toggle on 

Rulers, Guides, and a Grid to aid 

in positioning elements on the 

page. We can also access 

placement aids in the layout view 

context menu. Open this menu by right-clicking the page layout. 
 

We can set properties for these placement tools using the Layout View tab of the ArcMap Options 

dialog box, which is available from the Customize menu. Here, we can set the units and division 

values for the page ruler, and set the spacing for the grid.  
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Options on the Layout View tab also include ways to manage the appearance of the layout view. 

We can choose to stretch the contents of the view when the window is resized. 

To work with individual elements, select the element or elements 

we want to work with and right-click to open the element context 

menu.  Here we can zoom to, Cut, Copy, or Delete the selected 

element or elements from the page layout. In some cases we may 

want to convert a dynamic element, such as a legend or scale bar, 

to graphics in order to apply greater control over their display. The 

menu provides options to Group or Ungroup elements. Grouping 

elements is a good way of managing a page layout with many 

elements. 

This menu also provides commands to further manipulate graphics 

through Graphic Operations and placement commands. Placement 

commands include the ability to place elements in a specified 

drawing Order, Nudge, or move the element in a particular 

direction, Align, and Distribute multiple elements on the page. We can also Rotate or Flip an 

element. 

We can change the size of map elements by selecting them and dragging the selection handles. 

Dragging a handle in either direction will resize the element. We can also use the element's 

properties dialog box—Size and position tab—to position the element.  

Working with a Page Layout 
 

The Layout toolbar is used to navigate the page layout. It is enabled when we are in layout view. 

We can pan and zoom in/out on the page. We can also jump back and forth to previous page extents 

or specify a zoom percentage based on the page size. Other options for navigating in the page layout 

include the Layout View context menu, changing the active tool into a navigation tool by using 

the keyboard, and using the mouse wheel to zoom in and out.    
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We can access the layout context menu by right-clicking in any open 

area on the page. The layout context menu offers ways to work with 

the page layout. Along with access to the placement aids (Rulers, 

Guides, Grid, and Margins), this context menu provides a few  

commands to quickly change the view of the page, access the Page and 

Print Setup dialog box, Toggle Draft Mode, and work with selected 

elements. 
 

When in draft mode, using Toggle Draft Mode, the contents of the page 

elements are not drawn. Instead, only the bounding box of the frame 

and a label showing its name are drawn. We can control draft mode 

for individual elements through the Frame tab of the element's 

Properties dialog box. 

Grids and Graticules 

Grids and graticules are used to display coordinate positions on the earth. Graticules show lines of 

latitude and longitude for the earth, while grids show measured locations based on a coordinate 

system or can be used as a reference system for a grid index. For example, we can place a grid that 

divides a map into a specified number of rows and columns by choosing the reference grid type. 

ArcMap has three ways in which we can add grids and graticules to your map 

• Grids and Graticule Wizard 

• Custom overlay reference grids 

• Grid and Graticule layers 

Deciding which option to use depends on the requirements of the grid or graticule used in the map. 

 

Printing and Exporting Layout 

Once we have completed this work on your layout, we can print 

your map or create other types of output formats—PDF files, 

PostScript files, or Illustrator files. Under the file menu we have 

the options to open the Page and Print Setup dialog box, Print 

Preview, Print the page, or to Export Map. 
 

 

 

Reference: 

Esri. 2023. Using map templates 

https://desktop.arcgis.com/en/arcmap/latest/map/page-layouts/using-mxd-templates.htm 
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Google Earth Engine (GEE) Basics 

Mahmudul Hasan 

Geo-Data Specialist, ESRI Bangladesh 

Email: mhasanbd08@gmail.com 
 

Google Earth Engine combines a multi-petabyte catalog of satellite imagery and geospatial 

datasets with planetary-scale analysis capabilities. Scientists, researchers, and developers use Earth 

Engine to detect changes, map trends, and quantify differences on the Earth's surface. Earth Engine 

is now available for commercial use and remains free for academic and research use. 

 

Sign-up for Google Earth Engine 

If you already have a Google Earth Engine account, you can skip this step or visit 

(https://courses.spatialthoughts.com/gee-sign-up.html) for step-by-step instructions. 
 

01. Introduction 

The Code Editor is 

an Integrated 

Development 

Environment (IDE) 

for Earth Engine 

Javascript API. It 

offers an easy way to 

type, debug, run and 

manage code. Type 

the code below and 

click Run to execute it and see the output in the Console tab. 

mailto:mhasanbd08@gmail.com


79 | P a g e   

 

02. Working with Image Collections 

Most datasets in Earth 

Engine come as 

a ImageCollection. An 

ImageCollection is a 

dataset that consists of 

images takes at different 

time and locations - 

usually from the same 

satellite or data 

provider.  

 

03. Filtering Image Collections 

The collection contains all the imagery ever collected by the sensor. The entire collections are not 

very useful. Most applications require a subset of the images. We use filters to select the 

appropriate images. There are many types of filter functions. 

We will learn about 3 main types of filtering techniques, 

Filter by metadata: You can apply a filter on the image metadata using filters such 

as ee.Filter.eq(), ee.Filter.lt() etc. You can filter by PATH/ROW values, Orbit number, Cloud 

cover etc. 

Filter by date: You can select 

images in a particular date range 

using filters such as ee.Filter.date(). 

Filter by location: You can select 

the subset of images with a 

bounding box, location or geometry 

using the ee.Filter.bounds(). You 

can also use drawing tools to draw 

geometry for filtering. 

 



80 | P a g e   

 

04. Creating Mosaics and Composites from ImageCollections 

The default order of the collection is by date. So, when you display the collection, it implicitly 

creates a mosaic with the latest pixels on top. You can call. mosaic () on an ImageCollection to 

create a mosaic image from the pixels at the top. We can also create a composite image by applying 

selection criteria to each pixel from all pixels in the stack. Here we use the median () function to 

create a composite where each pixel value is the median of all pixels from the stack. 

 

05. Working with Feature Collections 

Feature Collections are like Image 

Collections - but they 

contain Features, not images. They 

are equivalent to Vector Layers in a 

GIS. We can load, filter and display 

Feature Collections using similar 

techniques that we have learned so 

far. 

 

 

06. Importing Data 

You can import vector or raster data into Earth Engine.  

 

07. Clipping Images 

It is often desirable to clip the 

images to your area of interest. You 

can use the clip () function to mask 

out an image using a geometry. 

 

 

08. Exporting Data 

Earth Engine allows for exporting both vector and raster data to be used in an external program. 

Vector data can be exported as a CSV or a Shapefile, while Raster can be exported 

as GeoTIFF files. We will now export the Sentinel-2 Composite as a GeoTIFF file. 
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Image Analysis on GEE 

Mahmudul Hasan 

Geo-Data Specialist, ESRI Bangladesh 

Email: mhasanbd08@gmail.com 

 

01. Earth Engine Objects 

This script introduces the basics of the Earth Engine API. When programming in Earth Engine, 

you must use the Earth Engine API so that your computations can use Google Earth Engine servers.  

02. Calculating Indices 

Spectral Indices are central to many aspects of remote sensing. Whether you are studying 

vegetation or tracking fires - you will need to compute a pixel-wise ratio of 2 or more bands. The 

most used formula for calculating an index is the Normalized Difference between 2 bands. Earth 

Engine provides a helper function normalized Difference() to help calculate normalized indices, 

such as Normalized Difference Vegetation Index (NDVI). For more complex formulae, you can 

also use the expression () function to describe the calculation 

03. Computation on ImageCollections 

So far, we have learnt how to run computation on single images. If you want to apply some 

computation - such as calculating an index - to many images, you need to use map (). You first 

define a function that takes 1 image and returns the result of the computation on that image. Then 

you can map () that function over the ImageCollection which results in a new ImageCollection 

with the results of the computation. This is like a for-loop that you may be familiar with - but 

using a map () allows the computation to run in parallel.  

04. Cloud Masking 

Masking pixels in an image 

makes those pixels transparent 

and excludes them from 

analysis and visualization. To 

mask an image, we can use 

the update Mask () function and 

pass an image with 0 and 1 

values. All pixels where the 

mask image is 0 will be masked. 

mailto:mhasanbd08@gmail.com
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05. Reducers 

When writing parallel computing code, a Reduce operation allows you to compute statistics on 

many inputs. In Earth Engine, you need to run reduction operations when creating composites, 

calculating statistics, doing regression analysis etc. The Earth Engine API comes with many built-

in reducer functions (such as ee.Reducer.sum (), ee.Reducer.histogram (), ee.Reducer.linearFit 

() etc.) that can perform a variety of statistical operations on input data. You can run reducers using 

the reduce () function. Earth Engine supports running reducers on all data structures that can hold 

multiple values, such as Images (reducers run on different bands), ImageCollection, 

FeatureCollection, List, Dictionary etc.  

 

06. Time-Series Charts 

Now we can put together all the skills we have learnt so far - filter, map, reduce, and cloud-masking 

- to create a chart of average NDVI values for a given location over 1 year. Earth Engine API 

comes with support for charting functions based on the Google Chart API. Here we use 

the ui.Chart.image.series () function to create a time-series chart. 
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Boro Rice Area Estimation with Google Earth Engine (GEE) 

Hasan Md. Hamidur Rahman, Director (Computer & GIS Unit) 

Bangladesh Agricultural Research Council 

Email: h.rahman@barc.gov.bd 

 

Steps for Boro Rice Area Estimation 

 
Flowchart of Boro rice area delineation:

a) Defining the RoI as 

whole Bangladesh 

b) Stack creation and 

spatio-temporal filtering 

of boro rice, Dec 2020-

Mar 2021 

 
c) Filter out cloud above 

20% 

Area coverage of boro rice 

 

 

Apply Machine Learning 

(ML) model CART, k-NN, 

RF and SVM for 

classification 

Sentinel-2 images   from 

GEE platform 

 

Field data collection 

of Boro rice and non-

rice signature using 

handheld GPS    

 

GEE Data Archive 

Compare the accuracy of the 

ML algorithms from 

confusion matrix and compare 

the area from all ML 

classification with BBS data 

and choose CART as the best 

one. 

mailto:h.rahman@barc.gov.bd
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Field/ Signature Data Collection and Processing 

1. Field Data Collection through GPS device 

2. The field data collected during boro seasons are compiled into an Excel sheet. The 

validated data is then saved as a CSV file, which serves as the attribute file. 

3. Simultaneously, the GPX file from the handheld GPS devices is downloaded and imported 

into Google Earth Pro to verify the survey locations.  

4. Polygons are drawn using the GPS points and digital photos for most of the fields. 

5. The file is exported in KML format and opened in QGIS, where it is converted into a 

shapefile. 

6. The shapefile is then joined with the attribute file (CSV) to merge the land types and other 

parameters. 

7. Non-rice land types are generalized into a single class called 'non-rice'. In the shapefile, 

there are two columns named 'id' and 'feature_name', where the value '0' represents 'non-

rice' and '1' represents ‘rice’ features.  

8. The generalized shapefile is imported into the Google Earth Engine (GEE) asset, where it 

is used as the signature data in the machine learning (ML) model. 
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     Screenshot of Boro Rice Classified GEE Raster Data (CART) 

 

   
                     

    Screenshot of Boro Rice Classified GEE Raster Data (k-NN) 
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Steps to Process Data in ArcGIS 

1. Boro Classified GEE Raster Data 

2. Boro Reclassified Mosaiced Raster Data 

3. Resampled Raster Data 

4. Boro Final Area Result. 

ArcGIS Tool for Raster Data Processing: 

▪ Arc Tool Box-> Spatial Analysis Tools->Reclass->Reclassify 

▪ Arc Tool Box-> Data Management Tools->Raster->Raster Dataset->Mosaic to New Raster 

▪ Arc Tool Box-> Data Management Tools->Raster->Raster Processing->Resample 

Boro Rice Area Map  

 

Boro Rice Area Comparison  

 

Sl. 
Classification 

Algorithm 

Pixel count 

(10m x 

10m) 

Area in  

Sq. Meter 

Area in 

Sq. km 
Area in Ha 

Classification 

Accuracy of 

Algorithm 

(%) 

Area 

Accuracy 

with 

respect to 

BBS (%) 

1 CART 419957945 41995794500 41996 4,199,579 96 88 

2 k-NN 384058603 38405860300 38406 3,840,586 97 80 

BBS Statistics 2020-21: 4,786,621 - - 
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Future Applications of GIS and Remote Sensing in 

Bangladesh Agriculture  

Md. Abeed Hossain Chowdhury Project Manager, Crop Zoning Project 

Bangladesh Agricultural Research Council 
Email: abeedchowdhury@gmail.com 

 

Introduction 
 

Bangladesh’s agriculture sector, which contributes 14.23% to GDP and employs 40.6% of the 

workforce (BBS 2023), faces challenges like climate change, soil degradation, and food security. 

Geographic Information Systems (GIS) and Remote Sensing (RS) offer transformative solutions 

by enabling data-driven, precision farming. 
 

Current Challenges in Bangladesh Agriculture 

• Climate change impacts (floods, droughts, salinity intrusion) 

• Land degradation and soil health issues 

• Low productivity and food security concerns 

• Need for data-driven decision-making 
 

 

Role of GIS & RS in Agriculture 

GIS Applications: 

• Crop suitability and Crop zoning 

• Land use/land cover mapping 

• Soil fertility analysis 

• Irrigation planning 

• Disaster management (flood, drought, salinity) and mitigation 
 

RS Applications: 

• Crop health monitoring (NDVI) 

• Drought/flood forecasting 

• Yield prediction 
 

1. Precision Agriculture & Smart Farming 

Applications: 

• Soil Health Monitoring: GIS maps soil nutrient levels, enabling site-specific fertilizer 

application (Crop Zoning, Khamari app). 

• Crop Health Assessment: Drones and satellites (e.g., Sentinel-2, Landsat) track NDVI 

(Normalized Difference Vegetation Index) to detect diseases early. 

• Automated Irrigation: Soil moisture sensors + GIS optimize water use, crucial for 

drought-prone regions. 

mailto:abeedchowdhury@gmail.com
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Future Potential: 

• AI-powered Drones for real-time pest detection. 

• Blockchain-integrated GIS for transparent supply chains. 

 

2. Climate Resilience & Disaster Management 

Applications: 

• Flood & Drought Forecasting: RS tracks water levels (using SAR data) and predicts 

impacts on crops. 

• Salinity Intrusion Mapping: Coastal areas (e.g., Satkhira, Khulna) use GIS-based 

salinity models to recommend salt-tolerant crops. 

• Early Warning Systems: Integrating NASA’s MODIS and Bangladesh Meteorological 

Department (BMD) data for cyclone alerts. 

 

Future Potential: 

• Machine Learning models to predict climate-induced yield losses. 

• Satellite-based crop insurance for farmers. 

 

3. Crop Yield Prediction & Food Security 

 

Applications: 

• Satellite-Based Yield Models: Using Sentinel-1 (radar) to estimate rice production before 

harvest. 

• Supply Chain Optimization: GIS maps storage facilities to reduce post-harvest losses 

(currently 15-20% in Bangladesh). 

 

Future Potential: 

• AI + Big Data Analytics for real-time yield forecasting. 

• Integration with IoT sensors in fields for hyper-local data. 

 

4. Land Use Planning & Policy Support 

Applications: 

• Crop Zoning: GIS identifies best-suited crops for specific regions (e.g., mangoes 

in Chapai Nawabganj). 

• Urban Encroachment Monitoring: RS detects illegal farmland conversions. 

 

 

Future Potential: 

• Digital Twin Technology for virtual farm simulations. 

• Policy Dashboards for the Ministry of Agriculture to track subsidies and schemes. 
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5. Challenges & Recommendations 

Key Challenges: 

• High costs of satellite/drone technology. 

• Limited technical expertise among farmers. 

• Data accessibility issues in rural areas. 

 

Recommendations: 

✓ Training Programs for Farmers and officials: Mobile apps (e.g., "Khamari Mobile App") 

with GIS insights. 

✓ Public-Private Partnerships (PPP): Collaborate with Google Earth Engine, NGO, FAO. 

✓ Government Initiatives: Expand Agricultural projects with AI-based GIS and RS 

(Satellite/Drone technology) tools. 

 

Conclusion 

GIS and RS are transformative for Bangladesh’s agriculture. The future of Bangladesh’s 

agriculture lies in scaling GIS and RS technologies to enhance productivity, sustainability, and 

climate resilience. With government support, private sector innovation, and farmer training, 

Bangladesh can become a leader in smart agriculture in South Asia. 


